Advanced Microsoft Excel

Lesson 6

1. Integrating Excel with Other Applications
1.1 Linking and Embedding
You can display a linked object or embedded object in a workbook exactly as it appears in the
source program or as an icon. If the workbook will be viewed online, and you don't intend to print
the workbook, you can display the object as an icon. This minimizes the amount of display space it
occupies. Viewers who want to display the information can double-click the icon.
1.
2.

Select Insert tab, Text group, and choose Object.
You can either create a new object, or directly create it from a file. If you want to link the data
to the source file, select the Link to file checkbox. Press [OK] to continue.

3.

The new object will be embedded to your worksheet..

1.2 Using Hyperlinks
A hyperlink is a link from a document that opens another page or file when you click it. The
destination is frequently another Web page, but it can also be a picture, or an e-mail address, or a
program. The hyperlink itself can be text or a picture.
When a site user clicks the hyperlink, the destination is shown in a Web browser, opened, or run,
depending on the type of destination. For example, a hyperlink to a page shows the page in the Web
browser, and a hyperlink to an AVI file opens the file in a media player
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You can use hyperlinks to do the following:

Navigate to a file or Web page on a network, intranet, or Internet

Navigate to a file or Web page that you plan to create in the future

Send an e-mail message

Start a file transfer, such as downloading or an FTP process
When you point to text or a picture that contains a hyperlink, the pointer becomes a hand, indicating
that the text or picture is something that you can click.
A URL (Uniform Resource Locator) contains a protocol, FTP, or FILE, a Web server or network
location, and a path and file name. The following illustration defines the parts of the URL:

 Protocol used (http, ftp, file)
 Web server or network location
 Path
 File name

To create a hyperlink, follow these step:
1. On a worksheet, click the cell where you want to create a hyperlink. You can also select an
object (such as a picture or an element in a chart) that you want to use to represent the
hyperlink.
2.
3.

Select Insert tab, Link group, and choose Hyperlink.
Enter the URL in the Address box of the Insert Hyperlink dialog, and press [OK] to confirm.

4.

The hyperlink is created for the specified cell. A tooltips will be displayed once you move your
mouse on that cell
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1.3 Using Excel Data in Word and PowerPoint Documents
Its many presentation features notwithstanding, Microsoft Excel is at heart an analytical tool. When
it comes time to organize information and present it to others, you’re likely to turn to two other
programs in the Microsoft Office System, Word and PowerPoint. Naturally, these programs are
designed to work hand-in-glove with Excel, so you can easily do your number crunching in Excel
and transfer the results to Word or PowerPoint when you need to make a verbal or visual
presentation

1.3.1 Pasting an Excel Table from the Clipboard
If you copy an Excel worksheet range to the Clipboard and then paste that range into Word, the
smart-tag menu that appears below the lower-right corner of the pasted data, shown in Figure 23-1,
provides quick access to the formatting options that Microsoft thinks you’re most likely to want.
These options are as follows:


Keep Source Formatting. Word receives the data as a block of HTML and creates a table,
preserving the fonts, alignment properties, numeric formatting, text color, and shading of your
original. In most, but not all, cases, this option (the default) is an adequate way to create a table
in Word that matches the appearance of your Excel data. After you have performed the paste,
you can use commands on Word’s Table menu to modify such characteristics as column widths
and the position of the table within surrounding text.



Match Destination Table Style. The data becomes a table in Word, but Word formats it as if
you had created the table directly in Word. Numeric formatting and character styles that you
used in Excel are preserved, but in most other respects your data will look as though you typed
it in Word rather than pasting it from Excel. If your default font in Word is Times New Roman,
for example, your table will appear in Times New Roman, regardless of what font you used in
Excel. Use this option if you want to make the table’s appearance blend in maximally with the
rest of your document. Note, however, that if your data in Excel uses non-default alignments,
you’ll probably need to do some formatting after it arrives in Word. As with the default choice
(Keep Source Formatting), Word’s Table menu is available to help you with column widths,
text-flow options, and so on.



Keep Text Only. If you choose this option, Word does not create a table. Instead, it simply
pastes each cell’s contents in the current default font, separating cells with single tab characters.
You might find this option useful if you’re simply copying a single column from Excel. Where
multiple columns are involved, the Keep Text Only choice usually produces a misaligned hash
in Word.



Apply Style or Formatting. This option behaves like the Keep Source Formatting option, but
causes Word to display the Styles and Formatting task pane, allowing you to apply styles or
character formatting immediately.
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2. Working with External Data
You can compile your data into Excel by retyping or by copying and pasting. But importing is most
effective when you're working with large amounts of data that would be time-consuming to enter
manually or too large to copy and paste. In addition, if you import your data, Excel can
automatically update your reports and summaries whenever the original source database is updated.

2.1 Import External Data Files
The main benefit of connecting to external data is that you can periodically analyze this data in
Excel without repeatedly copying the data, which is an operation that can be time-consuming and
error-prone. After connecting to external data, you can also automatically refresh your Excel
workbooks from the original data source whenever the data source is updated with new information.

2.1.1 Import a Text File
In order to import a text file in fixed-length or tab-delimiter format, follow these steps:
1.
2.
3.

Click the cell you want to put the data and then select Data tab, Get External Data group,
From Text.
Locate the file you want to imported
To specify how you want to divide the text into columns, follow the instructions in the Text
Import Wizard, and then click [Finish].
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4.

In the Import Data dialog box, click Properties to set formatting and layout options for the
imported data.

5.

In the Import Data dialog box, do one of the following:

To return the data to the location you selected, select Existing worksheet, and then click
[OK].

To return the data to a new worksheet, select New worksheet, and then click [OK]. Excel
adds a new worksheet to your workbook and automatically puts the external data range in
the upper-left corner of the new worksheet.

2.1.2 Import Microsoft Access Tables
In order to import a Microsoft Access table, follow these steps:
1.
2.

Click the cell you want to put the data and then select Data tab, Get External Data group,
From Access.
Locate the file you want to imported

3.

Specify which table you wish to import in the Select Table dialog, and then click [OK].

4.

Specify the location you want to place the import data and click [OK] to finish.
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2.1.3 Importing an XML List
In order to import a XML file, follow these steps:
1.

Click the cell you want to put the data and then select Data tab, Get External Data group,

2.

From Other Sources  From XML Data Import
If there is no schema for the XML, Excel will prompt you to create one.

3.

Specify the location you want to place the import data and click [OK] to finish.

2.2 Using a Query to Retrieve External Data
In most cases, you can import data by using the Import Data command as described in the preceding
section. Use Query or another program only if you need to perform specialized query tasks such as
the following:

Filter rows or columns of data before they
are brought into Excel.

Create a parameter query.



Sort data before it is brought into Excel.
Join multiple tables.

2.2.1 Perquisites of Using Query
To import data using Query, you must first:
1.

Install Query. Query including the Query Wizard, is an optional feature for Excel. Under most
circumstances, you are prompted to install Query when you point to Import External Data on
the Data menu and then click New Database Query.

2.

Install ODBC drivers. An ODBC driver is required to retrieve data in relational databases,
text files, or Excel using Query. When you install Query, you automatically install a set of
ODBC drivers. If you use a driver other than one installed with Query, you must install the
driver separately.

3.

Install data source drivers. A data source driver is required to retrieve OLAP source data.
Query supports connecting to databases that are created by using SQL Server OLAP Services;
when you installed Query, you automatically installed support for this type of OLAP database.
To connect to other OLAP databases, you must install a data source driver and client software.
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2.2.2 Creating a New Database Query
In order to import a Microsoft Access table, follow these steps:
1.
2.

Click the cell you want to put the data and then select Data  Import External Data  New
Database Query.
Select the databases in the Choose Data Source dialog. For example, we use the Access
database in this demo.

3.

Specify the location of the database file in the Select Database dialog.

4.

Select the columns you wished to import in the Choose Columns dialog of the Query Wizard.
You can use the [Preview Now] button to preview the import data. Press [Next] to continue.
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Define the selection criteria for the import data in the Filter Data dialog of the Query Wizard.
You can define up to three conditions here, and then press [Next] to continue.

6.

If you need to sort the data, you can define up to 3 sorting criteria for the data in the Sort
Order dialog of the Query Wizard.

7.

In the Finish dialog of the Query Wizard, you can use the [Save Query] to store the query
you created. In addition, you have 3 options to precede the import data.
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If you want to import the data to Excel immediately, select Return Data to Microsoft



Excel and press [Finish].
If you want to edit the query before import, select View data or edit query in Microsoft
Query and press [Finish].



8.
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If you want to create a data club for data mining, select Create an OLAP Cube from this
query and press [Finish] to popup the OLAP Cube Wizard.

Specify the location you want to place the import data and click [OK] to finish.
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2.3 Using a Web Query to Return Internet Data
Web queries can assist you in inserting refreshable data from the Web into your worksheets. Web
queries were available in earlier versions of Excel, but have been greatly improved. You can now
navigate to any Web page while setting up a Web query, the same way as you would navigate to that
page in your browser. Once you are at the page, you can select one or more tables by clicking the
icon images automatically added to the page by Excel
1.
2.

Click the cell you want to put the data and then select Data tab, Get External Data group, and
choose From Web.
Enter the URL in the Address box of the New Web Query windows and press the [Go] button
to retrieve the target web page.

3.

Select the data area you wish to import from the New Web Query windows, and then press
[Import] button to continue..

4.

Specify the location you want to place the import data and click [OK] to finish.
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2.4 Refresh Imported Data
Excel provides many options for refreshing imported data, including refreshing the data whenever
you open the workbook and automatically refreshing data at timed intervals. You can continue to
work in Excel while data is being refreshed, and you can also check the status of the refresh while
it's being refreshed.
If your external data source requires a password to gain access to the data, you can require that the
password be entered each time the external data range is refreshed.
When an external data range expands and additional records are returned, Excel can fill formulas in
adjacent columns or within the data range so that they remain next to the appropriate data.

2.4.1 Automatically Refresh Data when a Workbook is Opened
You can refresh an external data range automatically when you open the workbook, and optionally
save the workbook without saving the external data, so that the workbook file size is reduced.
1.
2.

Right click the imported external data, and select Data Range Properties.
Select the Refresh data when opening the file check box in the External Data Range
Properties dialog box.

3.

If you want to save the workbook with the query definition but without the external data, select
the Remove external data from worksheet before closing check box.
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2.4.2 Refresh Data in am Imported File
1.

If your worksheet contains more than one external data range that you want to refresh, right
click the imported data and click Refresh.

2.4.3 Require a Password to Refresh an External Data Range
If your data source requires a password to connect to it, you can require that the password is entered
before the external data range can be refreshed. This procedure does not apply to data retrieved
from a text file (*.txt) or a Web query (*.iqy). Please note that the stored passwords are not
encrypted. Moreover, Excel prompts for the password only the first time that the external data range
is refreshed in each Excel session. The next time you start Excel, you will be prompted for the
password again if you open the workbook that contains the query, and then click Refresh Data
1. Right click the imported external data, and select Data Range Properties.
2. Clear the Save password check box under Query definition section.

2.4.4 Preserve Cell Formatting when you Refresh an External Data
Range
1.
2.

Right click the imported external data, and select Data Range Properties.
Do one or both of the following under Data formatting and layout section:

If you want to preserve cell formatting that you apply, select the Preserve cell formatting
check box.


3.
4.

If you want to preserve column widths that you set, clear the Adjust column width check
box.

Click [OK].
To refresh the external data range, right click the imported data and click Refresh.
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2.4.5 Run a Query in the Background or While you Wait
Running a query in the background allows you to use Microsoft Excel while the query runs.
1.
2.

Right click the imported external data, and select Data Range Properties.
Select the Enable background refresh check box to run the query in the background or clear
it to run the query while you wait.

2.4.5.1 Stop a Query
To stop a query from running when Enable background refresh is turned off, press [ESC] button.

2.4.5.2 Stop a Background Refresh
To stop a query that is running in the background, double-click the Background Refresh
icon
on the status bar to display the External Data Refresh Status dialog box, and then click [Stop
Refresh].

2.4.5.3 Recording a Macro
While you are recording a macro that includes a query, Excel will not run the query in the
background. To change the recorded macro so that it runs in the background, edit the macro in the
Visual Basic Editor and change the refresh method for the QueryTable object from
"BackgroundQuery := False" to "BackgroundQuery := True".
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3. Collaboration and Security
3.1 Sharing Workbook
It has always been possible to share Excel files on a network. You just had to make sure that you
coordinated your efforts to avoid having more than one person open a file at the same time. Recent
versions of Excel, however, allow two or more people to work on the same workbook
simultaneously,
1.
2.

3.

Select Review tab, Change group, Share Workbook to popup the Share Workbook dialog,
Only one user is allowed to change the workbook by default. You can change some aspects of
the default behavior of shared workbooks. Each shared workbook user can set these options
individually. Use the first section on the Advanced tab to specify the length of time you want
to keep track of changes, or whether you want to track them at all.
Save your workbook.

3.2 Tracking
Excel can maintain and display information about how a worksheet was changed. Change tracking
logs details about workbook changes each time you save a workbook. You can use this history to
understand what changes were made, and to accept or reject revisions.
This capability is particularly useful when several users edit a workbook. It's also useful when you
submit a workbook to reviewers for comments, and then want to merge input into one copy,
selecting which changes and comments to keep
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3.2.1 Tracking Changes
Change tracking in Excel is closely linked with shared workbooks.
1.
2.
3.

Select Review tab, Changes group, Protect and Share Workbook.
Select Sharing with track changes check box in the Protect Share Workbook dialog.
If you click Sharing with track changes and then click [OK], change tracking for the shared
workbook is protected so no one in your workgroup can turn it off directly. However, anyone
can turn off the protection. To eliminate this possibility, you can enter a password in the
Protect Shared Workbook dialog box. But you must do this when the workbook is not in
shared mode. Then anyone who tries to turn off protection must enter the identical,
case-sensitive password.

3.2.2 Highlight Changes
You can decide at any time to go through each change that has been made to the shared workbook,
provided the Track Changes While Editing check box was selected in the Highlight Changes dialog
box when the worksheet was first saved for sharing.
1.
2.

Select the cell you wish to review, and then choose Select Review tab, Changes group,
Select Track Changes and its sub item Highlight Changes
Select the changes you wish to review in the Highlight Change dialog box.
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3.

The list for the change will be displayed in color for indication.

4.

If the List change on a new chance checkbox is select, the selected changes will be displayed
in a report in a new worksheet.

3.2.3 Accept or Reject Changes
1.
2.

Select the cell you wish to review, and then choose Select Review tab, Changes group, Select
Track Changes and its sub item Accept/Reject Changes.
Then you can accept or reject each change one by one.
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3.3 Protecting Files
Excel features related to hiding data or locking data with passwords are not intended to secure or
protect confidential information in Excel. These features are merely meant to obscure data or
formulas that might confuse some users or to prevent others from viewing or making changes to
that data. Excel does not encrypt data that is hidden or locked in a workbook. To help prevent
modification of confidential data and to help protect it from being viewed, you may want to limit
access to any workbook files that contain such information by storing them in locations that are
available only to authorized users. Excel provides several layers of security and protection to
control who can access and change your data:

For optimal security, you should protect your entire workbook file with a password, allowing


only authorized users to view or modify your data.
For additional protection of specific data, you can protect certain worksheet or workbook
elements, with or without a password. Use element protection to help prevent anyone from
accidentally or deliberately changing, moving, or deleting important data.

3.3.1 Securing a Workbook file
Password security at the workbook file level uses advanced encryption to help protect your
workbook from unauthorized access.
1.

Select File  Save As, and then select Tools  General Options in the Save As dialog.

2.

You can specify two separate passwords that users must type to and then save the workbook.


Open and view the file – This password is encrypted to help protect your data from
unauthorized access.



Modify the file – This password is not encrypted and is only meant to give specific users
permission to edit workbook data and save changes to the file.
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3.3.2 Protecting Specific Worksheet or Workbook Elements
When you share an Excel file so that others can collaborate on the data, you can prevent any user
from making changes to specific worksheet or workbook elements by protecting (or locking down)
certain parts of the file. You can also specify a password to allow individual users to modify specific
elements.
When you protect a worksheet, all cells on the worksheet are locked by default, and users cannot
make any changes to a locked cell. For example, they cannot insert, modify, delete, or format data
in a locked cell. You can, however, specify which elements users will be allowed to change when
you protect the worksheet.
1.

To protect a worksheet, select Review group, Change Tab, Protect Sheet. You can control
access to individual worksheet or chart sheet elements by selecting or clearing the following
check boxes

2.

To protect a workbook, select Review group, Change Tab, Protect Workbook. You can
control access to entity workbook by selecting or clearing the following check boxes.
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3.3.3 Permission to Access Specific Areas of a Protected Worksheet
Before you protect a worksheet, you can unlock the ranges that you want users to be able to change
or enter data in. You can:

Unlock cells for all users on the Protection tab of the Format Cells dialog box by choosing
Format  Cells.



Unlock cells for specific users in the Allow Users to Edit Ranges dialog box by choosing
select Review group, Change Tab, Allow Users to Edit Ranges.

Users whom you specify in the Permissions for range dialog box (Permissions button) can
automatically edit the range without entering the password. All other users are prompted for the
password when they want to edit the range.
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3.4 Recover Unsaved Excel Sheet
To save your effort and to save you from mess, there is a wonderful feature which will
automatically keep saving your Excel sheet at certain interval of time and will maintain revisions of
the same.
1.

To ensure that Auto Save option is turned on in your Excel, just click on the File, Options.

2.

On the Excel Options Window, Click the Save tab at the left hand pane. In the “Save
Workbooks” option, ensure that the option “Save AutoRecover information” is enabled.
Default time for saving is 10 minutes, you can increase or decrease it as per your needs. When
this option is enabled and you have been working on an Excel Sheet for 10 minutes or more
and you close it by mistake, you can recover up to last 5 AutoSave revisions of the same.
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To recover an AutoSave version of an excel sheet, click File, Info and check out the Version
and Manage Version option. Some important points related to AutoSave Feature are:
 Access up to the last five AutoSave versions of your previously saved active workbook. If
you save and close your workbook, all AutoSave versions will automatically be deleted. If
you close a previously saved workbook without saving, your last AutoSave version is kept
until your next editing session.
 Recover workbooks that were never previously saved. Unsaved workbooks are saved for
four days before they are automatically deleted.

4.

You can also recover the unsaved workbooks by opening File > Recent and selecting
“Recover Unsaved Workbooks”
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4. Merge Mail
Mail merge is useful for creating a set of documents that are essentially the same but where each
document contains unique elements. For example, in a letter that announces a new product,
company logo and the text about the product will appear in each letter, and the address and greeting
line will be different in each letter. Mail merge can be used to create:

A set of labels or envelopes – The return address is the same on all the labels or envelopes, but
the destination address is unique on each one.

A set of form letters, e-mail messages, or faxes – The basic content is the same in all the letters,



1.

messages, or faxes, but each contains information that is specific to the individual recipient,
such as name, address, or some other piece of personal data.
A set of numbered coupons – The coupons are identical except that each contains a unique
number.
This step in the mail-merge process involves two choices. First, choose the type of document
that you want to merge information into. Then, choose the main document that want to use.
The main document is the model for all of the merged documents that eventually create.

The Mail Merge task pane opens with a question about what type of merged document
you are creating (If you have fax support set up on your computer and a fax modem
installed, you will also see Faxes in the list of document types.). After you choose, click


Next at the bottom of the task pane.
If your main document is already open, or you are starting with a blank document, you
can click Use the current document. Otherwise, click Start from a template or Start
from existing document, and then locate the template or document that you want to use.
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To merge unique information into your main document, you must connect to the data file
where the unique information is stored. If you don't want to use all the data in the file in your
merge, you can choose the records that you want to use.

In this step in the mail-merge process, you connect to the data file where the unique
information that you want to merge into your documents is stored. If you have a Excel



worksheet that contains your customer information, click Use an existing list, and then
click Browse to locate the file.
Just because you connect to a certain data file doesn't mean that you have to merge
information from all the records in that data file into your main document. After you
connect to the data file that you want to use or create a new date file, the Mail Merge
Recipients dialog box opens. You can select a subset of records for your mail merge by
sorting or filtering the list.

3.

After you connect your main document to a data file, you're ready to add fields that indicate
where the unique information will appear in each copy of the document that you generate
when you merge. To make sure that Word can find a column in your data file that corresponds
to every address or greeting element, you may need to match fields.


If your main document is still blank, type the information that will appear in each copy.
Then, add fields by clicking the hyperlinks in the task pane. Fields are placeholders that
you insert into the main document at locations where you want unique information to
appear. For example, you can click the Address block or Greeting line links in the task
pane to add fields near the top of a new product letter, so that each recipient's letter
contains a personalized address and greeting. Fields appear in your document within
chevrons, for example, «AddressBlock». If you click More items in the task pane, you can
add fields that match any of the columns in your data file. For example, your data file
might include a column called Personal Note. By putting a Personal_Note field at the
bottom of a form letter, you can further personalize each copy. You can even customize
envelopes by adding a postal bar code — if you are using the English (U.S.) language
version of Word — or electronic postage.
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After you add fields to your main document, you are ready to preview the merge results. When
you're satisfied with the preview, you can complete the merge.

You can preview your merged documents and make changes before you actually complete
the merge


What you do now depends on what type of document you're creating. If you are merging
letters, you can print the letters or modify them individually. If you choose to modify the
letters, Word saves them all to a single file, with one letter per page.

X4-XT-CDP-0071-A @ Peter Lo 2016

24

Advanced Microsoft Excel

Lesson 6

5. Macro and VBA
If you perform a task repeatedly in Microsoft Excel, you can automate the task with a macro. A
macro is a series of commands and functions that are stored in a Microsoft Visual Basic module and
can be run whenever you need to perform the task. For example, if you often enter long text strings
in cells, you can create a macro to format those cells so that the text wraps.

5.1 Enable Developer Tab in Ribbon
1.
2.

Click the Microsoft Office Button, and then click Excel Options.
Click Popular, and then select the Show Developer tab in the Ribbon check box, and press
[OK] to confirm.

3.

The Developer tab will be enable to use.
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5.2 Record a Macro
5.2.1 Record a Macro using Macro Recorder
When you record a macro, Excel stores information about each step you take as you perform a
series of commands. You then run the macro to repeat, or play back, the commands. If you make a
mistake when you record the macro, corrections you make are also recorded. Visual Basic stores
each macro in a new module attached to a workbook.
1.

Select Developer tab, Code Group, Record Macros

2.

Perform the following action in the Record Macro dialog box.




In the Record Macro dialog box, enter a name in the Macro Name box
If you want to run the macro by pressing a keyboard shortcut key, enter a letter in the
Shortcut key box. The shortcut key will override any equivalent default Excel shortcut
keys while the workbook that contains the macro is open






In the Store macro in box, click the location where you want to store the macro. If you
want a macro to be available whenever you use Excel, select Personal Macro
Workbook.
If you want to include a description of the macro, type it in the Description box.
Click [OK]. If you want the macro to run relative to the position of the active cell, record
it using relative cell references. On the Stop Recording toolbar, click Relative Reference
so that it is selected. Excel will continue to record macros with relative references until

3.

you quit Excel or until you click Relative Reference again, so that it is not selected.
Carry out the actions you want to record.

4.

Select View tab, Code Group, Stop Macro when finish the record.
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5.2.2 Create a macro using Visual Basic Editor
1.
2.
3.

Select Developer tab, Code Group, Visual Basic
Select the Insert  Module in the Microsoft Visual Basic Editor.
Type or copy your code into the code window of the module.

4.
5.

If you want to run the macro from the module window, press [F5].
When you're finished editing, click File  Close and Return to Microsoft Excel.

5.3 Execute the Macro
The next time you need to flag a cell, you can run the macro. If you're going to use the macro
frequently, you can create a toolbar button for it, or assign a keystroke for it, or both.

5.3.1 Run your Macro Using the Tools Menu
1.
2.

Select View tab, Code Group, Macros to call the Macro dialog box.
Click the name of your macro, and then click Run.
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5.3.2 Create a Toolbar Button to Runs your Macro
1.
2.
3.

Click the Microsoft Office Button, and then click Excel Options, and in the Quick Access
Toolbar tab.
Select Macros in the Choose command from
Select the macro you want to assign and press the Add button, and then click [OK].

5.3.3 Assign a Keystroke to Run your Macro
1.
2.
3.

Click the worksheet, and then select Developer tab, Code Group, Macro.
Select the name of your macro, and then click [Options].
In the Shortcut key box, type the key to use along with [Ctrl] button to run your macro.

5.4 Managing your Macros
After you record a macro, you can view the macro code with the Visual Basic Editor to correct
errors or change what the macro does. For example, if you wanted the text-wrapping macro to also
make the text bold, you could record another macro to make a cell bold and then copy the
instructions from that macro to the text-wrapping macro.
The Visual Basic Editor is a program designed to make writing and editing macro code easy for
beginners, and provides plenty of online Help. You don't have to learn how to program or use the
Visual Basic language to make simple changes to your macros. With the Visual Basic Editor, you
can edit macros, copy macros from one module to another, copy macros between different
workbooks, and rename the modules that store the macros, or rename the macros.
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5.5 Introduction to Visual Basic Editor
5.5.1 Using the Visual Basic Editor
The Visual Basic Editor is a powerful tool that lets you extend the power and versatility of macros
beyond anything that can be done through recording alone.
1. Start Excel and open a new, blank workbook.
2.
3.
4.

Select Developer tab, Code Group, Visual Basic.
In the Project window, double-click ThisWorkbook.
Enter this code into the code window:
sub test( )
MsgBox "This is only a test."
end sub

5.

Save the file and then select File  Visual Basic Editor and close the workbook.

6.

Select Developer tab, Code Group, Macros in the Excel worksheet. Then select the previous
macro “text” we created in the Visual Basic Editor.

7.

Press [Run] to execute the macro and a message box will be displayed..
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5.6 Macro Security
In Microsoft Office Excel, you can change the macro security settings to control which macros run
and under what circumstances when you open a workbook. For example, you might allow macros
to run based on whether they are digitally signed by a trusted developer.

5.6.1 Macro Security Settings and their Effects
The following list summarizes the various macro security settings. Under all settings, if antivirus
software that works with 2007 Microsoft Office system is installed and the workbook contains
macros, the workbook is scanned for known viruses before it is opened.


Disable all macros without notification. Click this option if you don't trust macros. All
macros in documents and security alerts about macros are disabled. If there are documents that
contain unsigned macros that you do trust, you can put those documents into a trusted location.
Documents in trusted locations are allowed to run without being checked by the Trust Center
security system.



Disable all macros with notification. This is the default setting. Click this option if you want
macros to be disabled, but you want to get security alerts if there are macros present. This way,
you can choose when to enable those macros on a case by case basis.



Disable all macros except digitally signed macros. This setting is the same as the Disable all
macros with notification option, except that if the macro is digitally signed by a trusted
publisher, the macro can run if you have already trusted the publisher. If you have not trusted
the publisher, you are notified. That way, you can choose to enable those signed macros or trust
the publisher. All unsigned macros are disabled without notification.



Enable all macros (not recommended, potentially dangerous code can run). Click this
option to allow all macros to run. Using this setting makes your computer vulnerable to
potentially malicious code and is not recommended.



Trust access to the VBA project object model. This setting is for developers and is used to
deliberately lock out or allow programmatic access to the VBA object model from any
Automation client. In other words, it provides a security option for code that is written to
automate an Office program and programmatically manipulate the VBA environment and
object model. This is a per user and per application setting, and denies access by default. This
security option makes it more difficult for unauthorized programs to build "self-replicating"
code that can harm end-user systems. For any Automation client to be able to access the VBA
object model programmatically, the user running the code must explicitly grant access. To turn
on access, select the check box.
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5.6.2 Change Macro Security Settings
You can change macro security settings in the Trust Center, unless a system administrator in your
organization has changed the default settings to prevent you from changing the settings.
1.
2.

On the Developer tab, in the Code group, click Macro Security.
In the Macro Settings category, under Macro Settings, click the option that you want. Any
changes that you make in the Macro Settings category in Excel apply only to Excel and do not
affect any other Microsoft Office program.
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